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1 H5P 

Authoring Tool Activity Game based Learning  

1.1 A short description of the software and its main capabilities 

H5P is a free and open source content collaboration framework based on JavaScript. H5P, short for HTML5 
Package, aims to make it easy for everyone to create, share, and reuse interactive HTML5 content like 
interactive videos, interactive demos, quizzes, interactive timelines, etc. H5P is used by more than 17,000 
websites. The framework consists of a web-based content editor, a website for sharing content types, plugins 
for existing content management systems, and a file format for bundling HTML5 resources together. By 
default, the web-based editor is capable of adding and replacing multimedia files and text content in various 
H5P content types and applications. Additionally, content types can provide editors with custom widgets, 
enabling any type of editing capability and experience, including WYSIWYG editing of entire content types. 

1.2 Features 

H5P makes it easy to create interactive content by providing a range of content types for various needs. You 
can create interactive content by adding the H5P plugin to your WordPress, Moodle or Drupal site, or 
integrate it via LTI with Canvas, Brightspace, Blackboard and many other VLEs that supports LTI integration. 

Available content types: 
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1.3 Guidelines for installation and usage 

H5P can be used in two different ways, a user can either use H5P web editor to create interactive content 
or an H5P integration plugin can be installed on either of the platforms that it is available. 

 

In order to create interactive content on the online editor, the user has to visit H5P and then create an 
account. 

https://h5p.org/
https://h5p.org/user/register?destination=welcome-to-the-h5p-community
https://h5p.org/user/register?destination=welcome-to-the-h5p-community
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After creating the account successfully and logging on, the user will be redirected on his profile page, where 
he can click on the contents tab in order to proceed to create his first interactive content. 



 

This project has been funded with support from the European Commission. The publication 
[communication] reflects the views only of the author and the Commission cannot be held 
responsible for any use which may be made of the information contained therein. 

10 

 

 
 

When using the online editor , you can find multiple content templates either by searching on the available 
search bar or uploading from a third party. H5P also offers options for displaying download,copyright and 
embed buttons along with the content the user creates. 
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1.4 How to / tutorial 

Creating your own content using H5Ps’ templates is fairly easy. 

First, the user has to choose the templates that fits best for his needs. 
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Depending on the content type , there will be different media and fields that the author will have to fill. 
H5P offers built in tutorials that can be found on top of the page ,in case something is unclear when editing 
the template. 
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Furthermore, additional settings are included like behavioral settings or text overrides and translations for 
the author to set up. 
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1.5 Official website and link for download 

Official website 

Wordpress H5P Plugin 

 

 

1.6 Platform for Development 

H5P has a stand alone editor for creating interactive content that can be embedded in all shorts of 
platforms. Additionally users can author H5P content by installing the corresponding plugin on each 
platform that it is available. 

 

● Set up H5P for WordPress 
● Set up H5P for Moodle 
● Setup H5P for Drupal 

https://h5p.org/
https://h5p.org/wordpress
https://h5p.org/documentation/setup/wordpress
https://h5p.org/moodle
https://h5p.org/documentation/setup/drupal
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1.7 Generated Content and compatibility with the LMS and CMS platforms 
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2 i-Spring 

Authoring Tool Activity Game based Learning  

2.1 A short description of the software and its main capabilities 

iSpring Suite is a fast and user‑friendly eLearning toolkit that builds into your PowerPoint. With iSpring Suite, 
you can easily create a course, record narration, put together a quiz, and publish the course online — even 
with no experience in eLearning development. 

2.2 Features 

I-Spring depending on the license the user has acquired ,comes with a variety of features. 

The free version is limited in comparison to the i-Spring suite kit but it offers all the utilities someone would 
need to create interactive content. Some of its key feature are: 

● Course Publishing 
● Data Import/Export 
● Interactive Content 
● PowerPoint Conversion 
● Quizzes 

The i-Spring suite provides users with a vast variety of utilities and also comes with 24/7 live support from 
experts. 

 

Training 
 

● Documentation 
● Webinars 
● Live Online 

Features 

● Content Import / Export 
● Course Publishing 
● Instructor-Led Courses 
● Interactive Content 
● PowerPoint Conversion 
● Self-Paced Courses 
● Template Management 
● Test / Quiz Creation 
● Video Management 
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2.3 Guidelines for installation and usage 

 

Step 1  

Download i-Spring Free , by entering your email address and pressing the download button. 

 
 

Step 2 

 

Run the installation setup wizard, when the download is finished 

 

https://www.ispringsolutions.com/ispring-free/download
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Then you will have to read and accept the terms and conditions in order to proceed. 
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Finally, i-Spring should be installed and ready to be used. 
 

 
 

2.4 How to / tutorial 

 

The free i-Spring application is straight forward and fairly simple to use. The user can choose from the tab 
menu ,the type of interactive content he wants to create (Courses,Quizzes) and then proceed by pressing 
Create New in order to start a new project or Browse existing projects in the Recent Courses column. 
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For extra help, video tutorials , case studies and community posts can be found at the bottom of the 
application. There are also multiple video guides available in i-Springs Youtube Channel showing step by 
step the process of creating a course or a quiz. 

 

2.5 Official website and link for download 

● I-Spring Suite  
● Free Version 

 

 

2.6 Platform for Development 

I-Spring in an extension to Microsoft PowerPoint. 

 

2.7 Generated Content and compatibility with the LMS and CMS platforms 

Since i-Spring uses PowerPoint as base platform it creates scorm compliant outputs that can be integrated 
in Learning Management Systems. 

https://www.youtube.com/watch?v=0MVrIsYjMGk&t=64s&ab_channel=iSpring
https://www.youtube.com/watch?v=YZW_2kKZDzM&ab_channel=iSpring
https://www.ispringsolutions.com/pricing
https://www.ispringsolutions.com/ispring-free/download
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3 Audacity 

Video & Audio Creation 

3.1 A short description of the software and its main capabilities 

Audacity is an easy-to-use, multi-track audio editor and recorder for Windows, macOS, GNU/Linux and 
other operating systems. Developed by a group of volunteers as free and open source software . 

3.2 Features 
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3.3 Guidelines for installation and usage 

To install Audacity visit the Audocityteam webpage and simply click the Download button found at the top 
of the page. 
 

 
When the download has finished, click on the set up wizard and begin the installation process. 

After choosing your language of choice, press next on the set up wizard and proceed by reading  and 
accepting the terms and conditions. 

https://www.audacityteam.org/
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Next choose the location on your computer where audacitys’ program files will be installed. 
 

 
 

Audacity will continue to install its files and launch itself. 

3.4 How to / tutorial 

 

Audacity has a great web page manual with step by step guides accompanied with images , showcasing 
audacitys’ utilities. 

 

Audacity Basics 

https://manual.audacityteam.org/man/tutorials.html
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Importing Audio 
 

 
 

Audio Buttons 
 

Listen to the audio by clicking on the play ▶️ and stop , or you can use the Space button as a shortcut to play 

and pause. 

 
 

Spliting Audio 

 

● Click on the selection tool, and select the split point in the clip. 
● Then select Edit and Clip Boundaries. 



 

This project has been funded with support from the European Commission. The publication 
[communication] reflects the views only of the author and the Commission cannot be held 
responsible for any use which may be made of the information contained therein. 

26 

 

● Select Split. 
● Or use the keyboard shortcuts Command + I on the Mac or Control + I on the PC to Split the audio. 

 

Audio Fade 
 

● Click the Skip to End button to go to the end of the track. 
● Zoom in to see the last one or two seconds just before the end. 
● Click the waveform one second before the end. 
● Select > Region > Cursor to Track End. 
● Then, select Effect > Fade Out to make the audio smoothly fade out. 
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Export 
 

 

3.5 Official website and link for download 

Audacityteam Website 

3.6 Platform for Development 

Audacity is a stand alone application. 

3.7 Generated Content and compatibility with the LMS and CMS platforms 

Audacity generates standard audio and video files that are compatible with any LMS or CMS platform. 

 

  

https://www.audacityteam.org/
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4 Adapt Learning 

Authoring Tool Activity 

 

4.1 A short description of the software and its main capabilities 

It is an open-source HTML5 authoring software and is designed to create a responsive learning product on 
multiple devices through their Learning Pool Adapt Builder site. You enter a topic by tapping or clicking on 
the block and then scrolling the page, working your way through the content, opening and closing tabs in 
narrative sequences, image hotspots, and other interactive tools. Adapt creates HTML5 e-learning courses, 
which work on any device.  

The open-source version: 

● It's free 

● It consists of two products. The Framework and the Authoring Tool 

● It gives you the most control over branding and theming. This requires you to know some at least 
basic CSS. 

● You have control over version updates so you can always have the latest version built into core 
Adapt 

● You can import and export from one environment to another. You could create a course in the 
Framework, import into your authoring tool and then export into another friend's authoring tool 
etc. 

● It's still not the most polished experience out there due to the need to install and configure plugins 
etc. 

 

A hosted version provided by a company like Learning Pool, Can Studios or Adapt Unlimited: 

 

● They will set you up with an instance of the Adapt Authoring Tool on a server so you (and anyone 
you may work with) can access it anywhere. No technical knowledge required. 

● Each has their own varying level of additional features. Like their own themes, components, more 
polished UI, review tools. These additional features can make courses incompatible with open 
source Adapt. Adapt Unlimited (my own service) is based purely on OS Adapt. 

https://github.com/adaptlearning/adapt_framework
https://github.com/adaptlearning/adapt_authoring/
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● With large tenancy based versions. Framework updates can take ages due to problems with 
breaking existing courses. I think Learning Pool is still on version 2 of Adapt. 

● You have to pay a per-user licence fee of between $800 - 2000 per year 

4.2 Features 

Give its main features, its strong and critical aspects, like documentation, settings, tools, add-ons and if 
possible add screenshots.  

 

Adapt learning allows you to create a multi-device responsive learning product through their Learning Pool 
Adapt Builder site. It has built-in interactive elements such as image hotspots and multimedia files. It has 6 
different types of customizable questions, including multiple choice graphics, correspondence and cursor. 

All the documentation is clear and concise here. There are 276 plug-ins (listed here) 

 

 
 

Rather than having an old fashioned left-hand menu, menu blocks are presented on the first page so that it 
has a web-like feel. You enter a topic by tapping or clicking on the block and then scroll down the page 
working your way through the content, opening and closing tabs in accordions, narrative sequences, and 
image hotspots, just to name a few of the interactive tools on offer. It is a highly visual resource, as text 
scrolls above the image or images can be placed next to the text. The right selection of images works nicely 
as signposts for the content. Overall it is intuitive to figure it out from a learner point of view. Here are 
their showcase examples. 

You can watch videos, listen to audios with transcripts, and complete quizzes. Audio and video content as 
an mp3 and mp4 file work beautifully in this responsive design as it resizes according to the device you are 
using. However, you do have to be mindful of the appropriate file size unless it is a link from YouTube or 
Vimeo. Transcripts for audio and video can also be added in a number of ways – as an open and close 
transcript button or a pop-up window. 

Document resources can be added as a link within the content and/or in a separate resources menu. This is 
useful, because if there is a lot of content then the learner can download it and read it offline in their own 
time. 

https://learningpool.com/solutions/content-authoring-tool-adapt-builder/
https://learningpool.com/solutions/content-authoring-tool-adapt-builder/
https://www.adaptlearning.org/index.php/documentation/index.html
https://www.adaptlearning.org/index.php/plugin-browser/
https://www.adaptlearning.org/index.php/adapt-showcase/
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Adapt scales really well with large teams. A single developer can create a theme and set up an 
environment for their whole team and everyone can work together on a single server-based instance of 
Adapt. It can be technically challenging for inexperienced developers. Limited functionality compared to 
commercial alternatives. 

 

The support is mainly in the form of a user forum on GitHub.  

4.3 Guidelines for installation and usage 

The manual installation of the Adapt framework is here.  

Before you begin 

Installing Adapt requires the use of the command line. If your skills are a little rusty, the wiki article Just 
Enough Command Line for Installing might be all the assistance you need. 

Adapt does not require you to be an expert with the command line, just familiar with basic terminology and 
techniques. 

Prerequisites 

Before you get started with Adapt, you will need to install Node.js (the LTS version) and Git if you haven't 
already done so. Once you've got both Git and Node.js installed, the other components you'll need can be 
installed with the Node Package Manager - AKA npm - which comes installed with Node.js 

The Adapt framework consists of three main parts: 

1. The 'source' - the files you'll need to edit/work with, located in a folder called 'src' 
2. A 'task runner' - called Grunt - which takes the 'source' files and compiles them into: 
3. The 'build' - this folder contains the course that you will eventually upload to a web server or Learning 

Management System. 

The release of v0.10.0 makes it possible to import a course that was built in an older version of the Adapt 
framework into your authoring tool . With v0.10.0 of the authoring tool, when you attempt a cross-
framework import a screen tells you what the import is going to do to the course. 

When importing content from a different framework version, the authoring tool will examine each plugin 
used in the course for compatibility. It uses a traffic light system to tell you whether that plugin is supported 
in the authoring tool you are using, and consequently whether the import is possible. The categories are: 

● White – These plugins, as used in the course, match the version used in the authoring tool so there’s 
no problem. They won’t even appear on the import details screen. 

● Green – Your authoring tool uses a newer version of this plugin and the plugin in the course will  be 
updated automatically, by the authoring tool, during import. 

● Amber – The version of these plugins in your course are either not compatible with this authoring 
tool, or a newer version is already installed. The imported course will use the authoring tool’s existing 
version. You should test your course once imported. 

● Red – These plugins are not supported in this authoring tool. You must remove or update these 
plugins before you can continue with the import. 

So long as your course doesn’t have any red-rated plugins you will be able to import it; the imported course 
will now use the version of framework that your authoring tool runs on. 

If any red plugins are present the import is blocked. You will need to edit the course in an authoring tool 
using the framework the course was built with to remove/update these before you can try importing again. 

4.4 How to / tutorial 

 

Tutorial on YouTube: https://www.youtube.com/watch?v=6aBVcpvMZHQ 

https://github.com/adaptlearning/adapt_authoring/blob/master/CHANGELOG.md#090---2019-07-15%20(edited)
https://github.com/adaptlearning/adapt_authoring/blob/master/CHANGELOG.md#090---2019-07-15%20(edited)
https://github.com/adaptlearning/adapt_authoring/blob/master/CHANGELOG.md#090---2019-07-15%20(edited)
https://github.com/adaptlearning/adapt_framework/wiki/Manual-installation-of-the-Adapt-framework
https://github.com/adaptlearning/adapt_authoring/wiki/Just-Enough-Command-Line-for-Installing
https://github.com/adaptlearning/adapt_authoring/wiki/Just-Enough-Command-Line-for-Installing
https://www.youtube.com/watch?v=6aBVcpvMZHQ
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The learning design challenges it makes you think about - how to arrange the content in a meaningful way, 
what menu options help the learner navigate and progress nicely, and how the content needs to be set to 
work in the layout of the components. In the builder view, you can arrange the content and the interactive 
tools as components in an article. A page is created with a number of articles which appear as different 
sections for the learner. You could create the content so that it is highly structured, perhaps numbered in a 
linear fashion or you could allow the learner to make connections between meanings. It all depends on 
whether your learners are required to develop higher order learning skills or not, the length of time they 
have to complete it and what assessment tasks are required. 

 

Creating your first code instructions are here. 

4.5 Official website and link for download 

The official product’s website and the link for download it or purchase it: 

 

https://www.adaptlearning.org/ 

4.6 Platform for Development 

If it is a standalone application or a software is required for authoring 

 

It is a complete authoring standalone solution. Requires installation and configuration of the Adapt 
framework on a PC or local server. 

4.7 Generated Content and compatibility with the LMS and CMS platforms 

 

The Adapt Framework creates HTML5 e-learning courses. They may be delivered with a web server or a with 
SCORM compliant learning management system. The Adapt framework powers the Adapt authoring tool, an 
easy to use design tool for creating Adapt courses. 

The Adapt tool works for both to present your learning product as a learning resource or an online course. 
As a learning resource, it sits nicely within a Learning Management System in a blended learning context.  As 
an online course, it can provide all the information a learner needs. 

You can add assessments through quizzes. By setting up the appropriate extensions that work with your 
Learning Management System and with a bit of IT support you should see the results in the grade book. 
There is a range of question types that suits knowledge testing. It is difficult to have a reflective question 
though, one that doesn’t require precise correct/incorrect feedback. So one way around this is to use the 
open text quiz which has the option of providing a model answer or feedback only. 

 

 

  

https://github.com/adaptlearning/adapt_framework/wiki/Creating-your-first-course
https://www.adaptlearning.org/
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5 Adobe Captivate 

Authoring Tool Activity Game based Learning  

 

 

 

5.1 A short description of the software and its main capabilities 

Adobe Captivate is software for creating professional-grade eLearning courses and responsive learning 
experiences on mobile devices.  

It is a complete authoring solution that gives extensive control over all aspects of the courses and allows 
for customization via advanced elements such as objects, variables and triggers.  

It creates  eLearning courses with thousands of ready-to-go slides. Design complex branching logic and 
interactions without programming.  

Introducing Adobe Captivate video.   

5.2 Features 

Features are:  

Ready-to-go slides. Conquer the challenges of getting started with eLearning, and creating good-looking 
courses quickly. Design beautiful eLearning content in minutes with the all-new ready-to-go slides. From 
the assets panel, choose from hundreds of responsive ready-to-go slides and add them to your eLearning 
project. Easily replace text, characters, images, and videos to make your course engaging. Preview the 
mobile-ready content and publish it to be consumed across devices and browsers. 

Quick Start Projects. The all-new Quick Start Projects are a comprehensive set of ready-to-go interactive 
eLearning slides required for designing introduction, objectives, menu, layout, scenarios, interactions, and 
quiz slides. Choose a Quick Start Project from the Assets Panel, to create a new eLearning project. Simply 
swap out images, text, and other content to create enthralling courses in no time. 

All-new Asset Store. The all-new Asset Store is here to help you work smarter. Download ready-to-go 
slides from responsive QuickStart Projects to create stunning eLearning courses in no time. Unlock value 
with in-product access to Adobe Stock and our library of 75,000+ free eLearning assets. Choose from a 
universe of royalty-free images, characters, interactions, themes, games, scenarios, audio, video, buttons, 

https://www.adobe.com/products/captivate.html#introducing
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and much more. Find the perfect asset for your eLearning projects, and delight your learners with content 
that dazzles. 

Immersive learning with VR experiences. Battle shrinking attention spans with immersive learning 
scenarios that your learners can experience in Virtual Reality using VR headsets. Import 360° media assets 
and add hotspots, quizzes and other interactive elements to engage your learners with near real-life 
scenarios. Display text and image, play audio or video, or perform navigation based actions on click of a 
hotspot. Now Adobe Captivate makes it possible for you to customize the styling of a hotspot and its 
display text. Achieve learning use cases such as – “virtual tours”, “crisis management”, “safety drills”, “first 
responder situations”, and more. 

Fluid Boxes 2.0. Objects placed in Fluid Boxes get aligned automatically so that learners always get a fully 
responsive experience regardless of their device or browser. Use the predefined boxes in a responsive 
theme or draw your own. In the latest release of Adobe Captivate, Fluid Boxes get a productivity makeover 
- use the intuitive UI to control and customize your Fluid Boxes, view parent-child relations, distribute 
objects equally in a single click, define alignment properties in Static Fluid Boxes, and more. 

Interactive videos. Liven up demos and training videos by making them interactive. Record your own or 
bring in existing YouTube or Vimeo videos. Add informational slides or knowledge check questions as 
overlays at specific point on the video. You can now have multiple overlay slides play one after the other, 
at the same point on the video. Add bookmarks in the timeline to aid learner remediation. Customize 
feedback options for answers and interactions. 

Simplified Branching Workflow. Cross the hurdle of creating multi-module eLearning courses by authoring 
branching logic without programming. Download ready-to-go branching slides from the assets panel and 
swap out the text, image and other content in the different slide groups. Alternatively, group existing slides 
into modules. Create a menu that lists all the modules. Use proper naming convention to match the 
module names with the slide group names and find your multi-module course work seamlessly. Allow your 
learners to take a quiz only after all the modules are completed. 

Automated click-and-replace interaction. Accelerate your eLearning authoring by implementing click-and-
replace interaction without programming. Download a ready-to-go multistate interaction slide from the 
assets panel. Swap out the image, text and other content. use proper naming convention to map the 
interaction buttons with the corresponding object states. Allow forward navigation for learners, only after 
all the interactions are viewed or completed. 

Multiple theme support. Now get your eLearning content to look exactly the way you want it. In the latest 
version of Adobe Captivate, there are no restrictions on the number of themes in a project. Bring in 
different slides from existing courses to your eLearning project and keep the same theme as the original 
project. 

Image swap. Fast-track your eLearning authoring by simply swapping out images in your projects in 
seconds. Just drag and drop images of your choice to any existing slide in your project and see the old 
images get replaced by the new ones. 

Image and SVGs as buttons. Speed up your authoring by drastically reducing the number of steps required 
to use images or SVGs as buttons in your eLearning course. The latest update of Adobe Captivate, now 
allows you to add any image or SVG to your course and directly use them as buttons. Define actions or 
advanced actions and assign them to the button in a few simple steps. 

Copy Paste Appearance. Minimize authoring time by copying and pasting the appearance of one object to 
multiple other objects. Quickly apply similar formatting, such as color, font style, font size, and border style 
to different objects and text portions in your eLearning content. 

Theme fonts. Now breeze through eLearning authoring by editing fonts with a single click. Format the 
fonts of all the slides in your project, in one go, by editing the theme fonts. 

Smart Font Replacement. Boost your productivity with the smart font replacement features in the new 
Adobe Captivate. Easily comply with brand guidelines by uniformly changing the fonts, themes, and colors 
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of an eLearning project with the click of a few buttons. Resolve missing fonts to ensure your projects don’t 
lose their beautiful look and feel. Choose from a list of possible replacement fonts, if the fonts in your 
project are not available on your computer. 

Live device preview. See exactly how your eLearning content will play out on your learners’ VR devices. 
Use the live preview feature in Adobe Captivate to generate a QR code that you can scan using a mobile 
device and mirror the project real-time on your device browser. Once the initial connection is done, you 
can keep previewing all your work across projects as long as the Adobe Captivate session is active. 

360⁰ learning experiences. Augment the learning landscape with 360° images and videos and convert 
them into interactive eLearning material with customizable overlay items such as information blurbs, audio 
content & quizzes. Make learners explore their surroundings and actively engage with the environment to 
enhance retention. Achieve complex learning use cases such as compliance protocols in action, virtual 
walkthroughs, realistic product demos and more. 

Automatic chroma key effects. Transform your videos by making their backgrounds transparent and 
replace them in just a few clicks without the need for any green-screen technology. Personalize your video 
background by adding images or videos of places, scenarios or on-slide content. Get your project on the 
road with free media assets shipped with Adobe Captivate or choose your own. 

Smart video recording – webcam + screen. Create studio-quality HD videos as you simultaneously record 
your webcam and on-screen content with just a few clicks. Adjust the talking-head video position and add 
persona to your training content. Easily edit the videos in Adobe Captivate and add interactivity to multi-
screen video-based learning. 

CSV question import template. Reduce authoring time and effort with the .csv Question Import template 
in Adobe Captivate, which helps you automatically create question slides in your Adobe Captivate Project. 
Include all question slide logic in the same .csv file such as marks, correct answers and feedback. You can 
also import format-compatible question banks from other authoring tools with just a few clicks. 

 

 
 

PowerPoint to mobile learning. Fast-forward to smart eLearning authoring by importing PowerPoint 
presentations to Adobe Captivate with just a few clicks. Transform static PowerPoint slides into eLearning 
content that works seamlessly across all devices. Enhance the learning experience by adding interactive 
elements, assets and quizzes. 

Automatic device preview. Hit the play button to see your content automatically change shape and form 
factor across the full spectrum of device sizes. Get a holistic view of how responsive your content is on 
every screen size. 

Overlay slides. Add a new dimension of interactivity to recorded or streaming videos with overlay slides in 
Adobe Captivate. Mark any slide as an overlay slide and insert it anywhere on your video timeline allowing 
you to add additional interactive layers for improved learner engagement. 
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Multiscreen responsive eLearning authoring. Author as you always have—content automatically 
rearranges for the learner’s device. Use the in-product, device-specific preview to see how your project will 
appear. Publish as a single project and deliver a fully responsive experience to your learners. 

Best-in-class screen capture. Generate robust software simulations with multiple learning modes in a 
single recording session by capturing all on-screen actions, including mouse movements, system audio, and 
keyboard activity. Create a single, responsive screen capture project that plays seamlessly across devices. 
Adobe Captivate detects screen activity in the recording window and pans to those areas to create screen 
capture output for tablet and mobile views. 

Responsive text support. Provide a superior experience to learners, even for text-heavy courses delivered 
on small screens. Long paragraphs are collapsed to just a few lines, and learners can click to view more. 

Responsive themes. Choose from various themes that attractively blend backgrounds, styles, fonts, and 
layouts and incorporate Fluid Boxes. Fluid Boxes make it easy to render fully responsive content for 
multiple devices. Customize themes to meet your requirements, or create your own. Save themes for 
reuse across projects. 

Responsive motion effects without programming. Create fluid object transitions that include motion 
paths and rotations, even in responsive projects. Now add effects to individual objects and groups of 
objects. Define linear, custom, and scribble motion paths to control the way objects move. Preview 
animations on hover, and see how effects play out on the integrated Effects and Project timeline. Deliver a 
superior responsive learning experience by designing different effects for different devices. 

Customizable closed captions. Create courses that meet accessibility standards with closed captions 
generated from slide notes and for slide videos. These can be enhanced by controlling the way they look 
and where they appear. 

Device-specific previews. Eliminate the guesswork. Preview exactly how your content will look on specific 
devices by selecting from a preset device menu. Add new devices to the menu, as needed. 

Shared advanced actions. Enable conditional or multiple actions in an interaction or across projects, and 
create shared action templates to use with other modules and projects. Enhance shared actions with 
variable parameterization, and create a looping algorithm from within an advanced action. And now you 
can have one or more decision or conditional tables. 

Text to speech. Keep learners tuned in to your content thanks to automatic voiceover functionality that 
turns text into high-quality speech in a few clicks. Need to change the text? Just click once to update the 
audio. 

Responsive drag-and-drop interactions. Make eLearning fun with drag-and-drop games, quizzes, and 
learning modules that can run on any device. Choose from a variety of relationships between the drag item 
and drop target to implement learning outcomes more visually. Provide customizable audio feedback to 
every drag-and-drop attempt. 

It requires some training. It will be easier if you have some basic programming skills. It is best suited to 
experienced eLearning developers who are comfortable working with a little bit of programming.  

It is quite difficult to update and maintain existing content. 

 



 

This project has been funded with support from the European Commission. The publication 
[communication] reflects the views only of the author and the Commission cannot be held 
responsible for any use which may be made of the information contained therein. 

36 

 

 
 

5.3 Guidelines for installation and usage 

Provide a brief guideline of how to install and if possible add screenshots. 

 

Once you have purchased a version of Adobe Captivate, you will have the installation media: 

● Sign in to My Adobe to find serial numbers for registered products. 

● Or, see Find a serial number. 

● If you do not have a serial number, you can use Captivate as a trial for 30 days. 

● Make sure that your system meets the requirements for Captivate. For more information, see 
System requirements. 

● After downloading the installation files, see these instructions to extract the files and install your 
product.  

Here is the link to download. 

 

 

5.4 How to / tutorial 

Briefly explain how the software or the application works – if possible add screenshots and video tutorials. 

Training for beginners: click here 

5.5 Official website and link for download 

The official product’s website and the link for download it or purchase it: 

https://helpx.adobe.com/captivate/kb/captivate-downloads.html
https://elearning.adobe.com/2019/05/adobe-captivate-2019-training-beginners/
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https://www.adobe.com/it/products/captivate.html  

5.6 Platform for Development 

If it is a standalone application or a software is required for authoring 

It is a complete authoring standalone solution that gives extensive control over all aspects of the courses 
and allows for customization via advanced elements such as objects, variables and triggers.  

All system requirements are here. 

5.7 Generated Content and compatibility with the LMS and CMS platforms 

How to create a compliance course video. 

 

Publish to Adobe Captivate Prime and other LMSs. You can set up a smart learning ecosystem and deliver 
a superior experience to your learners thanks to tight integration between Adobe Captivate and Adobe 
Captivate Prime LMS. Publish your courses with a single click to Adobe Captivate Prime or to other leading 
LMSs. 

Adobe Captivate provides you options to make your projects SCORM/AICC-compliant and also creates the 
necessary files required for compliance to these standards. You can directly upload the published package 
to an LMS. Adobe Captivate allows for 'verbose' tracking - which means that both the correct answers and 
distractors are reported via AICC / SCORM or xAPI depending on developer output. You can also weigh the 
answers - assign partial and negative scores and even use advanced quiz responses on multiple-choice 
questions to provide feedback in context for selection of answer/distractors  - which can even trigger 
further actions. Adobe Captivate works with any Learning Management System (LMS) that are SCORM (1.2 
or 2004), xAPI (Tin Can), and AICC-compliant.  

Publishing to LMS: Workflow (LMS publishing, reporting, and tracking YouTube video) 

● Configure the project to report to LMS 

● Create a manifest file 

● Report button interactions 

● View and edit button interactions 

● Preview LMS 

● Publish the project for an LMS 

● Upload to an LMS 

 

How to Configure the project to report to LMS? Here is the link. 

In-product LMS preview. Eliminate the guesswork from content-LMS integration, get fine-grained control 
over all aspects of your course, and reduce dependency on your LMS administrator. Preview courses in 
Scorm.com to gauge LMS compatibility, and get error logs to identify those portions of the course that 
need attention. 

Roundtripping with Adobe CC. Work with the world’s best creative apps and roundtrip seamlessly with 
Adobe Photoshop, Adobe Illustrator, Adobe Audition and more in Adobe Creative Cloud. Preserve layers in 
imported Photoshop files, and edit or animate individual layers in Adobe Captivate for just the right effect. 
Edit and enhance audio files in Adobe Audition and then bring them back into Adobe Captivate. 

Accessibility support. Easily create simulations and demonstrations that address accessibility standards, 
such as Section 508 and Web Content Accessibility Guidelines 2.0 (WCAG 2.0). To help ensure that 
everyone can access your content, define text equivalents, insert clickable areas that allow keyboard 
access, and more. 

https://www.adobe.com/it/products/captivate.html
https://helpx.adobe.com/captivate/system-requirements.html
https://www.adobe.com/products/captivate/rapid-elearning.html#compliance
https://youtu.be/TyZbScygOqc
https://helpx.adobe.com/captivate/using/learning-management-system-lms.html
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6 Articulate Presenter 

Authoring Tool Activity Game based Learning  

 

 

6.1 A short description of the software and its main capabilities 

Easily author, narrate, and annotate presentation‑based courses right in PowerPoint.  

With this app and the Articulate 360 package, you can start building courses in PowerPoint and then add 
interactions and assessments, kick‑start the creative process, fine‑tune course elements thanks to the new 
timeline, which makes syncing course audio, animations, and annotations simple.  

Presenter 360 imports and records audio, imports and adjusts video in any format, and adds Flash movies, 
web objects, and interactive content to the slides. 

It has solutions for most eLearning tasks and authoring options for all levels of developers. 

The interface is similar to that of PowerPoint, but with more customization options. 

Deliver engaging courses to every device—without any additional work. Simply create your course in 
Presenter 360, then click publish. Your course automatically plays everywhere, beautifully. The responsive 
player dynamically adapts to every screen size, optimizes screen real estate, and supports touchscreen 
gestures that let learners swipe and drag to navigate. 

6.2 Features 

 

Transform slides into mobile and online courses. It includes an ever‑expanding set of relatable characters 
and slide templates to build pro‑looking courses.  

Presenter 360 integrates seamlessly with Engage 360 and Quizmaker 360, so you can easily engage and 
test learners. Add 20 media‑rich interactions from Engage 360 to capture learner attention. Create any 
quiz, survey, and decision‑making activity you want with Quizmaker 360. It takes just seconds to add 
Engage and Quizmaker content to your Presenter course. 
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You can create 20 types of interactions quickly and easily. Fully integrated with Presenter 360, Content 
Library 360 includes an ever‑expanding set of relatable characters and gorgeous slide templates you can 
use to build pro‑looking courses faster than ever. Content library collects more than 5 million photos, 
models, characters, videos and icons.  

 

Some training needed on the main tools, before starting developing courses. To take full advantage of 
Storyline's capabilities, it is needed to use layers, triggers, and variables.  

It is quite expensive and you can only pay all the enrollment costs at a time. There are no monthly charges.  
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At the end, you can speed project reviews. Finish projects faster with Review 360, the web‑based review 
app that’s part of Articulate 360. Simply upload your Presenter 360 course to quickly gather and share 
feedback. Stakeholders can see the latest version, make in‑context comments, and chime in on existing 
threads. And you can easily view, resolve, and respond to their feedback, keeping everyone in sync. 

6.3 Guidelines for installation and usage 

Choose your plan (you can get a 30 days free trial). After selecting your plan and features, you have to 
install the Articulate 360 desktop app, then use it to install Studio 360, which includes Presenter 360.  

Here is the link to sign up. 

6.4 How to / tutorial 

 

● Launch PowerPoint and, if prompted, choose a template. 

● Before you can work with any Presenter features, you'll need to save your new presentation. Press 
Ctrl+S or click Save on the Quick Access Toolbar. 

● Browse to a location on your local hard drive, give your presentation a name, and click Save. 

 

YouTube first step tutorial: https://youtu.be/moGBF08nXWo 

 

 

6.5 Official website and link for download 

The official product’s website and the link for download it or purchase it: 

https://articulate.com/360/studio#presenter  

6.6 Platform for Development 

Presenter 360 is not a standalone application but it requires at least: 

● Microsoft Office 365 (desktop apps only) 

● PowerPoint 2019 (32-bit or 64-bit) 

https://id.articulate.com/#eyJhdXRob3JpemVRdWVyeSI6eyJjbGllbnRfaWQiOiIwb2FhaGZ6cTQ0QTBSRXF2bTM1NiIsIm5vbmNlIjoiUzVoRWg3bFRSTDdaTkhlSEQwdWNvQkN0VHlLVzdSSlZyMzBCcmlUZVU0c3RjVHJyRFpSVWFQd2ZGeTY4WmxRZyIsInJlZGlyZWN0X3VyaSI6Imh0dHBzOi8vMzYwLmFydGljdWxhdGUuY29tL2F1dGgtY2FsbGJhY2siLCJyZXNwb25zZV90eXBlIjoiaWRfdG9rZW4gdG9rZW4iLCJzdGF0ZSI6ImV5SnBaQ0k2SWpZeE16bGxNVEkzTFdaaU5tSXROREF5TUMwNU5USTBMVGMxWmpZMll6WTVZV1ppTUNJc0luSmxaMmx6ZEhKaGRHbHZiaUk2SW5SeWFXRnNJbjA9Iiwic2NvcGUiOiJvcGVuaWQgcHJvZmlsZV9uYW1lIHN0YWZmIn19
https://youtu.be/moGBF08nXWo
https://articulate.com/360/studio#presenter
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● PowerPoint 2016 (32-bit or 64-bit) 

All system requirements are here. 

6.7 Generated Content and compatibility with the LMS and CMS platforms 

If you view a Presenter 360 course on your local hard drive (or send it to others to view on their local hard 
drives), you'll encounter security restrictions from the computer, web browser, and network that can cause 
various features of the course to fail. To test your published content and share it with others, upload it to 
the environment for which it was published.  

 

Publish your course to Review 360 to collect feedback from stakeholders and track version history. It’s a 
great way to collaborate on a project before distributing the finalized course to learners. 

● First, publish your course to Review 360. 

● Then, invite stakeholders to review the course. 

 

Publish for Web Distribution. If you don't need to track learners' progress or results, then web publishing 
is a good option. 

● First, publish your course for web distribution. 

● Then, do any of the following to get your course onto a web server: 

● Use the FTP option on the Publish Successful dialog to upload the published files to a web server. 

● Use your own FTP client to upload the published files to a web server. 

● Give the published files to your server administrator to upload to a web server. 

● Finally, give learners the URL for the presentation.html file, which is the file that launches your 
course. 

If you don't have access to a web server, here are some free options: 

● Tempshare is a free service provided by Articulate for testing published courses. The tutorial 
specifically mentions Storyline, but Temp Share also works for Studio courses. Note: Uploaded files 
will be deleted after 10 days. 

● Amazon S3 offers free hosting with generous usage limits. If you go over your limit, you'll be 
charged a small fee. See this video tutorial by Tom Kuhlmann to learn more about Amazon S3. 

● Google Cloud also has a free hosting service. You'll be charged a small fee if you go over the free 
limit. See this video tutorial by Tom Kuhlmann to learn more about Google Cloud. 

 

Publish for LMS Distribution. If you need to track learners' progress and results, another great option is to 
use your own learning management system (LMS). Presenter 360 supports Tin Can API (xAPI), SCORM 
2004, SCORM 1.2, and AICC LMSs. 

 

● First, publish your course for LMS distribution. 

● Then, click the Zip option on the Publish Successful dialog and upload the zip file to your LMS. 

● Finally, invite learners to your LMS to take the course. 

 

Publish for CD or Other Local Media. Need to distribute a course offline? Presenter 360 has an option for 
that. Just publish for CD, then deliver your course to learners via CD, DVD, USB drive, network drive, kiosk, 
or email. 

● First, publish your course for CD. 

https://articulate.com/support/article/System-Requirements-for-Articulate-Studio-360
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● Then, depending on how you plan to distribute your course, click Email, FTP, or Zip on the Publish 
Successful dialog. 

● Finally, instruct learners to double-click the Launch_Presentation.exe file to launch the course. 
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7 Elucidat 

Authoring Tool Activity Game based Learning  

 

 

7.1 A short description of the software and its main capabilities 

Elucidat is a cloud-based e-learning course authoring solution designed to speed up team production for 
high quality learning at any scale. With Elucidat, users are able to create and customize courses, control 
and secure content with role-based features, and measure the impact of courses. Key features include 
brand control, authoring and publishing controls, content management with an integrated media library, 
and data analytic dashboards and reporting. 

Elucidat allows users to create courses from multiple tested templates and control brand elements such as 
logos, web fonts, and colors across multiple projects from just one dashboard. Using Author mode, Elucidat 
provides plenty of course authoring tools such as a layout designer or a mobile responsive editor to make 
sure that users produce high quality content for increased engagement.  

With Elucidat you can: 

● easily produce high-quality digital learning 

● build interactive, engaging and mobile-friendly Elearning – faster than ever before 

● work collaboratively and efficiently at scale 

● effortlessly manage content on a global scale using team-level permissions, brand control and 
localization tools 

● generate real business impact through learning 

● deliver a better ROI by producing people-centred Elearning that makes a difference 

● keep up with high demand and business change 

● respond faster to the changing needs of your business with advanced processes, workflows and 
templates 

 

Elucidat offers online support via live chat, an online knowledge base, and built-in training and videos. 
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7.2 Features 

Elucidat works best for large learning teams and the world's biggest organizations, helping them produce 
and manage high-quality digital learning, at scale. It is expensive, especially if you don't produce a lot of 
eLearning content. The translation suite is only available to Enterprise plan users with 10,000 students. 

It is easy to insert interactive elements such as buttons, flip cards and input boxes. It's easy to manage 
content at scale with collaborative work and role-based development.  

Detailed information on how learners interact with their course via analytical dashboards. Main features 
are Creating tests and quizzes, managing video and audio, and filling a course with images and text. Easy 
authoring, Brand control, Engaging content, Quizzes and Assessments, User management & collaboration, 
Content Management, Publishing & Integrations, Analysis Security 

Other features (in alphabetical order):  

● Academic/Education 
● Activity Dashboard 
● API 
● Asynchronous Learning 
● Audio/Video Recording 
● Blended Learning 
● Built-in Course Authoring 
● Built-in LMS 
● Content Library 
● Content Management 
● Corporate/Business 
● Course Authoring 
● Course Publishing 
● Course Tracking 
● Customizable Branding 
● Customizable Questions 
● Customizable Templates 
● Data Import/Export 
● Engagement Tracking 
● Gamification 
● Interactive Content 
● Interactive Learning 
● Learner Portal 
● Mobile Access 
● Mobile Learning 
● Modeling & Simulation 
● Multi-Language 
● Quizzes 
● SCORM Compliance 
● Skills Tracking 
● Social Learning 
● Storyboarding 
● Synchronous Learning 
● Template Management 
● Tests/Assessments 
● Third Party Integrations 
● Training Companies 
● User Management 
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● Video Management 
● Virtual Classroom 

Less experienced content developers can create high quality output. 

You can create single courses that are responsive to any device. Not many options as with other authoring 
software to create custom interactivity or other elements. 

Experienced developers may feel limited by workflow and lack of flexibility. 

7.3 Guidelines for installation and usage 

Elucidat is cloud based and no installation is required. 

7.4 How to / tutorial 

Elearning inspiration, how-to guides and expert insights that will help you produce people-centered 
elearning. From videos on a dedicated channel on YouTube (how to start: click here) that will help you to 
make the most of the tools within Elucidat's authoring platform, to behind the scenes explainers to show 
how elearning examples were made. The Elucidat team aims to inspire you to produce elearning that 
delivers real-life impact. 

 
You can also book a personalized demo to get started. 

If you’re looking for help using Elucidat’s authoring platform, head over to the support center: 
http://help.elucidat.com/. 

Looking for more elearning inspiration? Check out the blog: https://www.elucidat.com/blog/ 

7.5 Official website and link for download 

The official product’s website and the link for download it or purchase it: 

 

https://www.elucidat.com/  

https://www.youtube.com/watch?v=Et1ztxofYqc
https://www.elucidat.com/
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7.6 Platform for Development 

Elucidat’s award winning authoring standalone platform makes it easy for large learning teams to quickly 
produce effective online learning that your end users will love.  

7.7 Generated Content and compatibility with the LMS and CMS platforms 

As a next generation authoring tool, Elucidat's platform produces high-quality, SCORM compliant HTML5 
elearning content. Supporting most elearning formats, as well as advanced xAPI data reporting and mobile 
responsive content, Elucidat is considered as one of the top SCORM elearning authoring tools for both Mac 
and Windows. 

For course publishing, Users can publish and release courses using an embedded web link, exportable 
SCORN files for any LMS or LRS, or direct upload to Elucidat Learning Launchpad. With Elucidat Analytics 
suite, users are able track and visual in-depth course metrics such as course engagement or device usage 
to identify potential content issues and resolved knowledge gaps. 

Supported Specifications: SCORM 1.2; SCORM 2004; Section 508xAPI/Tin Can API 
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8 Lectora 

Authoring Tool Activity 

 

8.1 A short description of the software and its main capabilities 

Lectora is a suite of tools designed to meet the diverse needs of course creators, from building core 
courses on slides to creating complex custom projects. It differs from other tools by including external 
services as part of the package, such as eLearning Brothers templates, avatar characters, and an interaction 
builder. It is possible to manage the content and updating of resources globally. 

It is available for free and on monthly and annual subscriptions.  

8.2 Features 

Lectora Inspire is a suite of rapid development tools that helps create interactive courses. Lectora is a main 
tool with many “plug-ins” included that you can use to create different types of content. It executes 
intricate branching navigation, click-to-reveal interactions, knowledge checks, quizzes and assessments, 
feedback popups, and more. Variety of modular templates, frameworks, and interactions.  

Support is extended via documentation and other online measures. 

 

Responsive Course Design. Lectora’s unique approach to mobile design is the most flexible of all tools. It 
gives you the most control of how your content displays across all devices. Content automatically adapts to 
the viewing device, but you can make adjustments as needed. 

 

Unmatched Interactivity. Make all your learning needs come to life with Lectora: 

● Execute intricate branching navigation, click-to-reveal interactions, knowledge checks, quizzes and 
assessments, feedback popups, and more. 

● Leverage animation, timeline, and event-based triggers to synchronize audio, video, and user 
actions in a sequence of timed events. 

 

All-New Framework Templates to Streamline Your Workflow. Quickly build instructionally sound and 
beautiful eLearning by utilizing all-new project templates including course frameworks, themes, style 
packs, and more! Jumpstart Course Creation with Built-in, Interactive Templates. Choose from a variety of 
modular templates, frameworks, and interactions from the Lectora Asset Library all maximized for mobile 
use and accessibility: 

● Stunning course starter templates in fresh designs.  
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● Page layouts, interactions, knowledge checks, quizzes, and more 

● Pre-built beautiful and versatile themes and style packs 

● Getting-started frameworks 

 

Built-In Asset Library. Easily enhance courses with icons, characters, stock assets, and more. 

 

 
 

 

Screen Recorder & A/V Editor. Select the screen area to record, add your webcam, and go! 

Personalize courses with video using the most user-friendly screen recording and editing tool imaginable. 
Record with your webcam and sync up with your slides. Liven up your video recording with text, images, 
animations, and transitions. Edit audio tracks in just a few clicks. There is a steep learning curve with 
limited support. The built-in audio and video editors have limited recording capabilities 

 

The Accessibility Leader. Create a better experience for all learners. You never set out to purposely create 
barriers to learning. But if you’re not keeping accessibility in mind from the very start of your course 
design, you may be creating such barriers. Lectora’s built-in accessibility settings lead the industry and give 
you the capabilities you need to ensure all your learners receive the most effective training possible. 

 

Translation & Text to Speech. Engage a global workforce: 

● 7 languages: English, French, German, Spanish, Swedish, Chinese (Mandarin) & Brazilian Portuguese 

● Save time importing and exporting translation files with XLIFF (XML Localization Interchange File 
Format) 

 

Personalized, Adaptive Learning. Track & react to learner behavior. Dynamically address skill gaps with 
BranchTrack for scenario-based branching (integrated with Lectora). Use built-in variables and conditions 
to create custom learning paths that adapt based on click behavior. Create advanced learning experiences 
to guide behaviors and maximize learners’ performance. 
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PowerPoint Import. Quickly convert your PowerPoint slides into pages in your course. Upload and 
transform PowerPoint presentations into engaging eLearning in a just few clicks. 

 

Simply insert a PPT file directly into an existing course or template by clicking the icon on the tool ribbon, 
add an assessment, publish, and go! Or, transform static slides into instructor-led training with Lectora’s 
built-in screen recorder. 

 

Collaborative Authoring. Work with others without losing your work (and your mind). Automatically log 
course revisions to help you track version history and communicate changes to remote team members. 
Track the version of each course to ensure you always deliver the most current eLearning available. 

 

ReviewLink. Share. Collaborate. Succeed. With ReviewLink as part of Lectora, stakeholders and subject 
matter experts can provide comments throughout your course, which means fewer revisions and speedy 
approvals. 

 

Additionally, it comes with an administrative dashboard, which lets users assign projects to reviewers and 
send request notifications to team members, streamlining approval processes. Lectora Online enables 
administrators to encrypt critical data and grant editing permissions to specific users.  

8.3 Guidelines for installation and usage 

Once you have purchased a product or service, you will log in the webapp, choosing your language, user ID 
and password. 
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Here is the link to log in. 

8.4 How to / tutorial 

Lectora is a user-friendly, award-winning authoring tool available as both a cloud-based and desktop 
solution. Part of the eLearning Brothers Authoring Suites, Lectora empowers you to quickly create, WCAG-
friendly interactive eLearning courses that achieve extraordinary results. With more productivity shortcuts 
than any other authoring tool, Lectora is as simple or advanced as you need it to be. 

 

How to start a Lectora course tutorial here. 

8.5 Official website and link for download 

The official product’s website and the link for download it or purchase it: 

 

https://www.elearningbrothers.com/create-learning/lectora  

8.6 Platform for Development 

Lectora Online is a cloud-based learning management solution that provides small to large enterprises with 
authoring tools to design, publish and deliver courses on multiple platforms. It enables users to collaborate 
with team members and automatically track revised content using versioning capabilities. 

8.7 Generated Content and compatibility with the LMS and CMS platforms 

Easily implement and use HTML, CSS, and Javascript. Publishing Flexibility. Track learner performance by 
publishing to an LMS/LRS. Publish to any format including SCORM, xAPI, HTML5, AICC, cmi5, and more. 
Publish directly to the Rockstar Learning Platform, SABA, Healthstream™, Docebo®, SCORM Cloud, and 
more.  

Lectora Online allows businesses to import/export question banks on the platform and embed quizzes or 
media files into formative assessments. Managers can access various digital assets including photos, 
videos, templates and sound effects from the in-built media library.  

 

 

  

https://eu.lectoraonline.com/app/login
https://youtu.be/xzYnm-zjpBw
https://www.elearningbrothers.com/create-learning/lectora
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9 Audiotool 

Video & Audio Creation 

9.1 A short description of the software and its main capabilities 

Audiotool is an award-winning, online digital audio workstation (DAW) that runs right in your browser. 
Without the need for installation, Audiotool gives you all the tools you need to produce music 
professionally and unleash your creative potential.  

9.2 Features 

Modular Structure 

All of the Audiotool devices can freely be added to the app's desktop where cables can be manually 
dragged from input to output mirroring the workflow of early electronic musicians. 

Samples & Presets 

Enjoy an ever growing, community fed cloud based library of over 1,000,000 samples. There are also over 
200,000 device presets accessible through the various device's preset browsers. 

Cloud Production 

All track assets are stored on the Audiotool servers. This means you can access your work from any 
browser in the world without worrying about further software installations. 

● Collaborate & Control 
● Synthesizers 
● Drum Machines 
● Mixing & Routing 
● Effects 
● Dynamic & Spectrum 
● Sample-Editor Probe 
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9.3 Guidelines for installation and usage 

 
 

9.4 How to / tutorial 

https://youtu.be/-GZFU2xU0Vs 

https://www.audiotool.com/help/tutorials 

 

9.5 Official website and link for download 
https://www.audiotool.com/ 

 

9.6 Platform for Development 

Independent. 

https://youtu.be/-GZFU2xU0Vs
https://www.audiotool.com/help/tutorials
https://www.audiotool.com/
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9.7 Generated Content and compatibility with the LMS and CMS platforms 

Audiotool is a powerful online music production studio right in your browser 
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10 Open Shot 

Video & Audio Creation 

10.1 A short description of the software and its main capabilities 

OpenShot Video Editor is an award-winning, open-source video editor, available on Linux, Mac, and 
Windows. OpenShot can create stunning videos, films, and animations with an easy-to-use interface and rich 
feature-set. 

10.2 Features 

 

 
 

10.3 Guidelines for installation and usage 

OpenShot Video Editor is available for download on Linux, OS X, and Windows. We provide both direct 
download links and torrents. 

 

 
 

 

 

10.4 How to / tutorial 
https://www.openshot.org/videos/ 

https://cdn.openshot.org/static/files/user-guide/quick_tutorial.html 

 

https://www.openshot.org/videos/
https://cdn.openshot.org/static/files/user-guide/quick_tutorial.html
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Step 1 – Import media files 

Before we can begin making a video, we need to import media files into OpenShot. Most video, image and 
music file formats will work. Drag and drop a few videos or images and a music file from your Desktop to 
OpenShot. Be sure to drop the files where the arrow in the illustration is pointing to. 

Step 2 – Arrange Videos and Photos on Timeline 

Next, drag each video or photo onto a track in the timeline (as seen in the illustration). The timeline 
represents your final video, so arrange your photos in whatever sequence you want them to appear in your 
video. If you overlap two clips, OpenShot will automatically create a smooth fade between them, displayed 
by blue rounded rectangles between the clips. Remember, you can rearrange the clips as many times as 
needed by simply dragging and dropping them. 

Step 3 – Add Music to Timeline 

To make our creation more interesting, we need to add some music. Click on the music file that you imported 
in step 1, and drag it onto the timeline. If the song is too long, grab the right edge of your music clip, and 
resize it smaller (that will make it end earlier). You could also insert the same file multiple times, if your music 
is too short. 

Step 4 – Preview your Project 

To preview what our video looks & sounds like, click the Play button under the preview window. You can 
also pause, rewind, and fast-forward your video project by clicking the corresponding buttons. 

Step 5 – Export your Video 

Once you are happy with your project, the next step is to export your video. This will convert your OpenShot 
project into a single video file, which will work on most media players (such as VLC) or websites (such as 
YouTube, Vimeo, etc…). 

Click on the Export Video icon at the top of the screen (or use the File > Export Video menu). Choose from 
one of the many preset export options, and click the Export Video button. 

10.5 Official website and link for download 

https://www.openshot.org/download/ 

10.6 Platform for Development 

OpenShot Video Editor is free software. 

10.7 Generated Content and compatibility with the LMS and CMS platforms 

 
 

 

  

https://www.openshot.org/download/


 

This project has been funded with support from the European Commission. The publication 
[communication] reflects the views only of the author and the Commission cannot be held 
responsible for any use which may be made of the information contained therein. 

57 

 

11 Reaper 

Video & Audio Creation 

11.1 A short description of the software and its main capabilities 

DAW – Digital Audio Worksttion – Open source – Reaper is a full suit for Audio works, compromising all the 
aspects of the production chain including video sync. 

11.2 Features 
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11.3 Guidelines for installation and usage 

 

https://dlz.reaper.fm/userguide/ReaperUserGuide645c.pdf 

A new REAPER 6 license includes unlimited free updates through REAPER version 7.99. Frequency 
varies, but updates are typically released every few weeks. 

These updates include bug fixes, feature improvements, and significant new features, all of which are free. 
Updates only take a minute or so. All preferences and configurations are preserved, and forward and 
backward compatibility are maintained. 

 

 

11.4 How to / tutorial 

https://youtu.be/iQM12Rx0Hf0 

11.5 Official website and link for download 

https://www.reaper.fm/userguide.php 

11.6 Platform for Development 

Software 

https://dlz.reaper.fm/userguide/ReaperUserGuide645c.pdf
https://youtu.be/iQM12Rx0Hf0
https://www.reaper.fm/userguide.php
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11.7 Generated Content and compatibility with the LMS and CMS platforms 
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12 Shotcut  

Video & Audio Creation 

12.1 A short description of the software and its main capabilities 

Shotcut is a free, open source, cross-platform video editor. 

12.2 Features 

● Wide Format Support 
● Support for the latest audio and video formats thanks to FFmpeg 
● Supports popular image formats such as BMP, GIF, JPEG, PNG, SVG, TIFF, WebP as well as image 

sequences 
● No import required - native timeline editing 
● Frame-accurate seeking for many formats 
● Multi-format timeline: mix and match resolutions and frame rates within a project 
● Webcam capture 
● Audio capture 
● Support for 4K resolutions 
● Network stream playback (HTTP, HLS, RTMP, RTSP, MMS, UDP) 
● Frei0r video generator plugins (e.g. color bars and plasma) 
● Color, text, noise, and counter generators 
● EDL (CMX3600 Edit Decision List) export 
● Export single frame as image or video as image sequence 
● Videos files with alpha channel - both reading and writing 
● Tone mapping HDR to SDR 

12.3 Guidelines for installation and usage 

 

12.4 How to / tutorial 

https://shotcut.org/tutorials/ 

12.5 Official website and link for download 

https://shotcut.org/download/ 

http://www.ffmpeg.org/general.html
https://frei0r.dyne.org/
https://en.wikipedia.org/wiki/Edit_decision_list
https://shotcut.org/tutorials/
https://shotcut.org/download/
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12.6 Platform for Development 

Software. 

12.7 Generated Content and compatibility with the LMS and CMS platforms 
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13 Quizlet 

Activity Game based Learning  

13.1 A short description of the software and its main capabilities 

Quizlet is a global learning platform that provides and enables the use of attractive learning methods for 
repetition and memorisation of any material with the help of prepared tools. Users can create a free account 
or subscribe to Quizlet Plus for teachers. Subscription allows the creation of advanced learning materials and 
formative assessments to track user progress. 

Quizlet takes information and converts it into flashcards, quizzes, games (e.g. timed games or drag and drop 
games) or tests. Users can create own sets of educational materials or use content from the Quizlet library. 
After logging in, users are granted access to Quizlet Live – a type of a quiz show in which many participants 
can participate at the same time. Quizlet converts information into seven different modes (six study modes 
and single game modes). Quizlet provides users with access to, among others: learning packages, diagram 
packages, study modes (including flashcards, written exercises or tests) and games. 

13.2 Features 

● Easy to use online application.  
● Many ready-to-use educational materials and interactive charts.  
● Available types of activities: tests, writing, memory games, flashcards. 
● Possibility to integrate with Microsoft Teams and Google Classroom. 
● The ‘test’ mode does not save progress (test needs to be completed at one go). 
● The memory game shows only eight pairs of cards – to learn more, different games need to be 

taken. 
● Additional features are not available in the free version. 
● There are five study modes (flashcards, learn, write, spell, tests) and two game modes. 
● Quizlet offers the following features: Quizlet Live, Learn, Explanation, Flashcards, Mobile, Quizlet 

Plus, Quizlet Plus for instructors. 
● Quizlet Live requires at least 4 players. 

13.3 Guidelines for installation and usage 

The user registers at https://quizlet.com/en-gb, after clicking on the ‘Get started’ button (Fig.10). To register, 
the following details must be provided: date of birth, e-mail address, username and a password; the user 
also has to choose the teacher or parent option, tick off the ‘I accept the Quizlet Terms of Use and Privacy 
Policy’ box  and click on the ‘Register’ button. (Fig. 11). Under the ‘Welcome to Quizlet’ tab, you may create 
a class (enter the ’Class Name’ and the ’Description’), while under the ’Select a School’ tab, you may add the 
name of your school, company or institution (Fig. 11). 

 

https://quizlet.com/en-gb
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Fig. 10. Registration page for the Quizlet platform 

Source: https://quizlet.com/en-gb [access: 12/01/2022] 

 

 

            
Fig. 11. User registration on Quizlet 

Source: https://quizlet.com/sign-up [access: 12/01/2022] 

 

Tutorial: https://help.quizlet.com/hc/en-au/articles/360040762212-Teachers-Getting-started 

13.4 How to / tutorial 

Once you have logged into your classroom (Fig. 12), click on the ’Create’ icon, name the question set you 
are creating and add a description to the question. 

 

https://help.quizlet.com/hc/en-au/articles/360040762212-Teachers-Getting-started
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Fig. 12. Creation of a questionnaire on the Quizlet platform 

Source: https://quizlet.com/Tommtomm999 [access: 12/01/2022] 

 

The form (Fig. 13) contains windows for entering terms and their definitions (as text or images).  Once the 
word is entered in the ‘term’ box, different language options for its definition will be displayed (you can 
choose the language). You can use them or leave the box empty and add an image (a paid option). When 
you finish typing, click ‘Done’. 

 

 
 

Fig. 13. Entering questions on the Quizlet platform 

Source: https://quizlet.com/pl/658802784/security-flash-cards/ [access: 12/01/2022] 

 

The developed set of questions can be shared (after clicking ‘Share’) by copying the generated direct link to 
the resource or using the option to share the set via Google Classroom, Remind or Microsoft Teams (Fig. 
14). 
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Fig. 14. Adding questions on the Quizlet platform 

Source: https://quizlet.com/pl/658802784/security-flash-cards/ [access: 12/01/2022] 

 

The developed set of questions can be presented in the form of educational content: Flashcards, Learn, 
Write, Spell, Test, Match, and the Gravity game (Fig. 15). 

     

    
 

Fig. 15. Examples of learning forms on the Quizlet platform 

Source: https://quizlet.com/658802784/learn [access: 14/01/2022] 

 

Tutorials:  

● https://help.quizlet.com/hc/en-au 
● https://help.quizlet.com/hc/en-au/categories/360001598951-Teaching 

https://help.quizlet.com/hc/en-au
https://help.quizlet.com/hc/en-au/categories/360001598951-Teaching
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● https://help.quizlet.com/hc/en-au/categories/360001601132-Studying 

13.5 Official website and link for download 

https://quizlet.com/ 

13.6 Platform for Development 

It is an educational platform and an application for electronic devices. 

13.7 Generated Content and compatibility with the LMS and CMS platforms 

● CMS compatible via the Quizlet platform 
● Compatible with LMS through the Quizlet platform 
● Compatible with Google Classroom, Remind, Microsoft Teams 

 

 

  

https://help.quizlet.com/hc/en-au/categories/360001601132-Studying
https://quizlet.com/
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14 Mentimeter 

Activity  

14.1 A short description of the software and its main capabilities 

Mentimeter is an audience engagement platform that makes it easy for users to build presentations and 
collect polls, data, and opinions. Presentations can be supplemented with questions, surveys, quizzes, 
images, and GIFs. 

Mentimeter is a simple and intuitive tool that can be used in both remote and onsite user meetings. It allows 
users to receive immediate feedback on their questions. Users answer questions using their computers or 
smartphones, where they open a designated page and enter an access code received from the questioner. 

Presentations, quizzes and word clouds created with Minimeter are interactive and participants’ reactions 
and their answers are displayed in real time, regardless of the poll type (remote, hybrid, face-to-face). 
Opinions are collected based on a survey in which multiple choice, scale-based, image-based, rated, or 
open-ended questions can be used. In the free version only a limited number of questions can be asked. 
However, even this version is very useful for simple polls. 

14.2 Features 

● Simple and intuitive test and poll creator. 
● Browser and mobile device-supported. 
● It enables users to create simple presentations with interactive quizzes (single or multiple choice), 

polls or classic slides. 
● Up to 2 slides with questions and up to 5 quiz slides can be created in the free version. 
● Mentimeter offers different opinion collection and presentation forms: e.g. word clouds, image 

selection, scales, answer rating (100 points), open answers, or simple quizzes. It enables teachers to 
verify students’ knowledge in real time.  

● Unprocessed data can be exported to an .xls file. Presentations may be downloaded as a screenshot 
or a .pdf file. 

● All features are available in the Pro version. 

14.3 Guidelines for installation and usage 

The user registers at https://www.mentimeter.com/, after clicking on the ‘Sing up’ button (Fig. 16). To 
register, the user needs to enter their e-mail address, password and user name, and then select the ’Work’, 
‘Eukaction’ or ’Other’ option and confirm it (’Save selection’) (Fig. 17). 

 
Fig. 16. User registration on Mentimeter 

Source: https://www.mentimeter.com/ [access: 17/01/2022] 

https://www.mentimeter.com/
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Fig. 17. User registration on Mentimeter 

Source: https://www.mentimeter.com/ [access: 17/01/2022] 

14.4 How to / tutorial 

After logging in, click ‘New presentation’ and ‘Create presentation’. You may choose different presentation 
types under the ’Type’ tab (Fig. 18), e.g.: 

1. ‘Popular question types?’ – if we want to receive answers to the question, we can choose the 
following: 

● ’Multiple choice’ – users select one of the options; 
● ‘Word cloud’ – users create a word cloud from the answers given; 
● ‘Open ended’ – we get more answers; 
● ‘Scales’ – users rate on a scale; 
● ‘Ranking’ – users put the given answers in a certain order; 
● ‘Image choice’ – users make a choice using an image; 
● ‘Q&A’ – users ask questions that the tutor can display and answer. 

2. ‘Quzi Competitiom?’ – we create a quiz: 
● ’Select answer’ – quiz with closed questions; 
● ‘Type answer’ – quiz with open questions. 

3. ‘Content slide’ – add variety to the prepared presentation by, among others: 
● ’Heading’ – it allows you to add a title slide; 
● ‘Image’ – it allows you to add a photo; 
● ‘Big – it allows you to add a large text size. 

4. ‘Advanced’ – it offers additional options, e.g.: 
● ’100 Points’ – it allows you to split a hundred points between several different features; 
● ‘2X2 Grid’ – allows you to present particular answers on a graph; 
● ‘Who will win?’ – it allows you to vote for the best photo, work, etc. 

https://www.mentimeter.com/
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Fig. 18. Presentation creation on Mentimeter 

Source: https://www.mentimeter.com/ [access: 17/01/2022] 

 

When you want to display the prepared presentation, click ‘Present’ and when it is ready, click on the ‘Share’ 
button to share it (Fig. 19). This generates a link, a QR code and an access code valid for two days. To answer 
the questions, users have to go to https://www.mentimeter.com/ and enter the code at the top of the page. 
The answers are then automatically displayed on the screen. 

 

 
Fig. 19. Presentation sharing on Mentimeter 

Source: https://www.mentimeter.com/ [access: 17/01/2022] 

 

Tutorials:  

● Some helpful guides: https://www.mentimeter.com/how-to 
● How To Create Your First Mentimeter Presentation:  

https://www.youtube.com/watch?v=IQwGklW62v8 
● https://www.mentimeter.com/features 
● Templates: https://www.mentimeter.com/templates/speakers 
● Discover all about Mentimeter: https://www.mentimeter.com/features 
● https://www.youtube.com/watch?v=hNf-wQWlRlY 
● https://www.youtube.com/watch?v=pBIQNjSvhiE 

 

14.5 Official website and link for download 

https://www.mentimeter.com/ 

https://www.mentimeter.com/
https://www.mentimeter.com/
https://www.mentimeter.com/how-to
https://www.youtube.com/watch?v=IQwGklW62v8
https://www.mentimeter.com/features
https://www.mentimeter.com/templates/speakers
https://www.mentimeter.com/features
https://www.youtube.com/watch?v=hNf-wQWlRlY
https://www.youtube.com/watch?v=pBIQNjSvhiE
https://www.mentimeter.com/
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14.6 Platform for Development 

It is an educational platform and an application for electronic devices. 

14.7 Generated Content and compatibility with the LMS and CMS platforms 

● CMS compatible via the Quizlet platform 
● Compatible with LMS through the Quizlet platform 
● Compatible with Zoom, Microsoft Teams 
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15 Sticky Notes 

Activity 

15.1 A short description of the software and its main capabilities 

Sticky Notes is a plugin for moodle. It is an easy-to-use activity to build a post-it wall for your 
brainstorming, pedagogic uses, ranking, meeting, ideas organization.... You can create, update and move 
sticky notes in different columns as a kanban, change background color and vote for sticky notes as you 
wish ! 

15.2 Features 

When creating an activity, teacher can define which background colors will be used between the 6 default 
colors, and add a meaning/caption for each color if necessary. Teachers can edit any notes, while users 
updates only their own notes. 

The vote function can be enabled in order to "like" some notes. 

Teacher can also enable or define : 

● number of notes per user 

● number of votes per user if enabled 

● enable the rotate effect for notes for accessibility 

● view authors (only for teachers) 

During the activity, the student can: 

● create, update, delete and move his own notes 

● vote for notes if enabled 

15.3 Guidelines for installation and usage 

In order to install this plugin in Moodle you need to have administrative rights on the platform.  

1. Download the plugin from 
https://moodle.org/plugins/view.php?plugin=mod_stickynotes&moodle_version=31 

2. Login in Moodle with site wide administrative rights 
3. Click on Site Administration 
4. Select the Plugins tab 
5. Click on Install Plugins 
6. Under the “Install plugin from ZIP file” click on Choose file and from the File Piker window click on 

Choose file. 
7. In the window titled “Open” navigate to the folder where the zipped file is located (that is the 

zipped file you downloaded in step 1) and click on Open  
8. Finally, click on install plugin from the zipped file and follow the steps. 

Sticky Notes Setup 

1. Once Sticky notes have been installed, to change the settings of the plugin go to Site 
Administration, then click on the Plugins tab and then click on plugins overview. 

2. Scroll in the list to find the Sticky Notes plugin  
3. Click on Settings 
4. The only setting you can change in Sticky notes is the default colors of the sticky notes. Sticky notes 

offer 6 colors which you can change by clicking on the color palette. 
5. Once done click on Save Changes  

https://moodle.org/plugins/view.php?plugin=mod_stickynotes&moodle_version=31
https://icourse.projectsgallery.eu/moodle/admin/tool/installaddon/index.php
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15.4 How to / tutorial 

Creating an activity using Sticky notes 

1. Login on Moodle with an account that has at least Course Creator rights. 
2. Click the course in which you wish to add a Sticky Notes Activity. 
3. Under the desired Topic, click on Add an activity or Resource link and select Sticky Notes 

 
1. Write and Activity Name and optionally write the description of the activity

 
4. Under Notes Settings you have the option to Display the description of the activity, Limit how many 

notes a user can add and type in a maximum number of votes. You can also select the option to 
display which student wrote each note, and rotate the notes randomly.  

 
5. Under the Section Votes Settings you can selecting in the Vote Type the “Like  Votes”  option, 

which enables the participants to “Like” one or more sticky notes. You can also Limit the number of 
Likes by enabling the option and adding a Max Votes Number.  
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6. Under the section Color Settings you can enable or disable the option Let user choose background 
color for notes. You can also enable to Display a Caption for each color i.e. Yellow means Hate, Red 
means Love etc. Then, under each color you need to right them meaning of each color. 

7. Click on Save and Display. The next screen appears that enables you to create labeled columns for 
the students to add their sticky notes. Click on the + sign to add and name your columns. 

8. Click on Save and Close 

15.5 Official website and link for download 

https://moodle.org/plugins/view.php?plugin=mod_stickynotes&moodle_version=31 

15.6 Platform for Development 

Moodle 

15.7 Generated Content and compatibility with the LMS and CMS platforms 

Activity in Moodle 

 

 

 

  

https://moodle.org/plugins/view.php?plugin=mod_stickynotes&moodle_version=31
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16 StudentQuiz  

Activity 

16.1 A short description of the software and its main capabilities 

StudentQuiz enables students to collaboratively create their own question pools in Moodle. Students can 
filter these questions into quizzes, and they can rate and comment questions while working through the 
quizzes. StudentQuiz computes each students contribution and learning progress and compares this with 
the community. The created questions become part of the Moodle question bank and can be reused in 
other Moodle quizzes.  

16.2 Features 

Students like quizzes to prepare for exams. However, it’s hard to create all the questions needed for 
assessments and exams. That’s where the Moodle plugin StudentQuiz comes in. StudentQuiz enables 
students to collaboratively create their own question pools within Moodle. This allows a better learning 
experience because knowledge is actively constructed by the learner, not just passively received from the 
environment. And even if an individual student contributes a few questions only, a larger cohort can easily 
build up an extensive question pool.  

In StudentQuiz, learners can create individualised quizzes. They also add their feedback to each questions 
by rating and commenting while working through the quizzes. Students can see their personal learning 
progress, and they can compare their contribution and competence with their peer group. Furthermore, 
the created questions become part of the Moodle question bank and can be reused in standard Moodle 
quizzes. 

The teacher can approve/disapprove questions, or hide or delete questions. The teacher can also 
configure: 

• whether students’ names are displayed or kept anonymous. 

• whether questions are published right away or have to be approved first. 

• the number of points assigned to questions contributed and answers given.  

• what user roles to exclude from participation. 

• what questions types are allowed to be added to the pool. 

• whether students are enforced to rate questions. 

• whether students are enforced to comment questions. 

The video StudentQuiz in a minute provides a quick introduction. There's also the 16 mins  video Tutorial 
for Teachers. 

StudentQuiz is available in many languages. 

 

16.3 Guidelines for installation and usage 

In order to install this plugin in Moodle you need to have administrative rights on the platform.  

1. Download the plugin from https://moodle.org/plugins/mod_studentquiz 
2. Login in Moodle with site wide administrative rights 
3. Click on Site Administration 
4. Select the Plugins tab 
5. Click on Install Plugins 
6. Under the “Install plugin from ZIP file” click on Choose file and from the File Piker window click on 

Choose file. 

http://tube.switch.ch/videos/d0e37788
https://tube.switch.ch/videos/d91a8a0d
https://tube.switch.ch/videos/d91a8a0d
https://moodle.org/plugins/mod_studentquiz
https://icourse.projectsgallery.eu/moodle/admin/tool/installaddon/index.php
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7. In the window titled “Open” navigate to the folder where the zipped file is located (that is the 
zipped file you downloaded in step 1) and click on Open  

8. Finally, click on install plugin from the zipped file and follow the steps. 

 

StudentQuiz Settings 

1. Once StudentQuiz has been installed, to change the settings of the plugin go to Site Administration, 
then click on the Plugins tab and then click on plugins overview. 

2. Scroll in the list to find the StudentQuiz plugin and click on Settings. The following screen appears: 

 
3. In the StudentQuiz settings, under Ranking Settings you can change how many points are allocated 

when student published a question, approved a question, rated a question, answered a question 
etc. You can also exclude specific roles in ranking. 

4. Under Question Settings you can select the type of questions that will be available and select 
whether rating and commenting is enforced. 
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5. Once done click on Save Changes  

 

16.4 How to / tutorial 

Watch a Short Video https://tube.switch.ch/videos/d0e37788 

Documentation: https://docs.moodle.org/34/en/StudentQuiz_module 

16.5 Official website and link for download 

https://moodle.org/plugins/mod_studentquiz 

16.6 Platform for Development 

Moodle Plugin 

16.7 Generated Content and compatibility with the LMS and CMS platforms 

Quizzes created by Students in Moodle 

  

https://tube.switch.ch/videos/d0e37788
https://docs.moodle.org/34/en/StudentQuiz_module
https://moodle.org/plugins/mod_studentquiz
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17 SWIPE 

Activity 

17.1 A short description of the software and its main capabilities 

With Swipe, you can get feedback on text, images and videos in a fun interactive way. The swipe feedback 
activity is a fun and simple activity where users can provide feedback on images, text or videos, displayed 
on a deck of cards that can be swiped right if liked, or swiped left if disliked. 

At the end of the deck the user has the opportunity to provide some more feedback by entering some text 
to be read by the teacher that setup the deck. 

Teacher and admin can see how many times somebody liked / disliked a card and read the feedback given 
at the end of the deck. The activity is designed to work well on desktop and on mobile devices, it even 
works for users logged in as guest in Moodle. 

17.2 Features 

• Teacher or admin can add images, videos and text in cards. 

• Students can provide feedback on the cards presented to them. Students can also provide feedback 
after all cards are presented to them 

• Teachers can see how many times somebody liked / disliked a card and read the feedback given at 

the end of the deck 

17.3 Guidelines for installation and usage 

In order to install this plugin in Moodle you need to have administrative rights on the platform.  

1. Download the plugin from https://moodle.org/plugins/mod_swipe 
2. Login in Moodle with site wide administrative rights 
3. Click on Site Administration 
4. Select the Plugins tab 
5. Click on Install Plugins 
6. Under the “Install plugin from ZIP file” click on Choose file and from the File Piker window click on 

Choose file. 
7. In the window titled “Open” navigate to the folder where the zipped file is located (that is the 

zipped file you downloaded in step 1) and click on Open  
8. Finally, click on install plugin from the zipped file and follow the steps. 

 

17.4 How to / tutorial 

Creating an activity using Swipe 

1. Login on Moodle with an account that has at least Course Creator rights. 
2. Click the course in which you wish to add a Swipe Activity. 
3. Under the desired Topic, click on Add an activity or Resource link and select Swipe  

https://moodle.org/plugins/mod_swipe
https://icourse.projectsgallery.eu/moodle/admin/tool/installaddon/index.php
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4. Write the Activity Name and optionally write the description of the activity

 
5. At the bottom of the screen click Save and Display. The next screen appears as shown below:  
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6. Click on Edit Cards 
7. To add a card click on Add Card. In the new screen that appears you type in a name for the card, 

and from the content type you can select the content of the card: Text, Image or Video 

 
 

8. Depending on the Type you have selected the corresponding box will be enabled in order to type 
text or upload an image or a video. 

9. Once done, click on Save and Close. 
10. Repeat in order to add as many cards as you wish. 

17.5 Official website and link for download 

https://moodle.org/plugins/mod_swipe 

17.6 Platform for Development 

Moodle 

https://moodle.org/plugins/mod_swipe
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17.7 Generated Content and compatibility with the LMS and CMS platforms 

Moodle 
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18 DEBATE 

Activity 

18.1 A short description of the software and its main capabilities 

The debate is a moodle activity that allows students to debate on a given topic inside moodle. 
It is common in any face to face class that moderators or teacher or even employees are divided into group 
and they are asked to give their opinion or debate on a given topic. This plugin is the approach to take that 
whole scenario inside moodle. 

18.2 Features 

Debate is an activity that you can add in a moodle course. It allows you to: 

• Create teams in debate activity: You can create multiple teams for a debate activity for positive 

and negative side for a group of users. You will need to use the groups feature inside the course, 

create groups and use those groups as a part of each team. Each team can have: 

1. A name of the team. 

2. Number of responses allowed for the team. 

3. The side of the team, either positive or negative. 

4. The selection of groups for each team will determine which user goes to which team. 

• Control the response from the users: These are the following options available when it comes to 

accepting response from the users: 

1. Unlimited response - users can add as many positive and negative response as they want. 

2. Allow one response on one side - only one response is allowed on any one side, either 

positive or negative. 

3. Allow one response on each side - allow anyone to respond either on the positive or 

negative side. 

4. Use debate teams - use teams feature instead which will control these for individual teams. 

• Control of activity completion of the module: These are the types of completion you can use: 

1. User viewing the debate activity (and/or). 

2. User submitting the required number of debate responses. 

(for example, the user will have to submit 2 responses to complete this module) 

Debate also: 

• logs all types of activities inside the debate instance 
o Visiting a debate instance. 

o Adding a debate instance. 

o Updating a debate instance. 

o Deleting a debate instance. 

o Adding a debate response. 

o Updating a debate response. 

o Deleting a debate response. 

• introduces capabilities for users and other roles inside a course 
o Add a new debate instance: allows users to add a new debate activity inside the course. 
o View debate content: View the debate page where the actual debate will happen. 
o Delete any debate response: Allows moderators or teachers to delete debate responses 

from users. 
o Delete own debate response: Gives the user the capability to delete their own response. 
o Update own debate response: Gives the user the capability to update their own response. 
o Manage debate teams: Gives a teacher or manager the capability to create, update 

Guidelines for installation and usage 
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18.3 Guidelines for installation and usage 

In order to install this plugin in Moodle you need to have administrative rights on the platform.  

1. Download the plugin from https://moodle.org/plugins/mod_debate 
1. Login in Moodle with site wide administrative rights 
2. Click on Site Administration 
3. Select the Plugins tab 
4. Click on Install Plugins 
5. Under the “Install plugin from ZIP file” click on Choose file and from the File Piker window click on 

Choose file. 
6. In the window titled “Open” navigate to the folder where the zipped file is located (that is the 

zipped file you downloaded in step 1) and click on Open  
7. Finally, click on install plugin from the zipped file and follow the steps. 

18.4 How to / tutorial 

Creating a debate activity in a course 

Adding a debate activity is simple, just the usual way, go to the course, turn editing on and add the 

activity. A debate activity will have three parts: 

1. A name of the activity (a usual moodle activity name). 

2. The topic of the debate (the actual topic where the users will debate on). 

3. Activity description, a usual moodle field where you can upload pictures or other descriptions 

which can be viewed on either of the course page or the debate page or both. There is a 

checkbox while adding or deleting a debate instance allows to set up this feature. 

 

1. If you wish to control the user response you can select: 

● Unlimited response - users can add as many positive and negative response as they want. 

● Allow one response on one side - only one response is allowed on any one side, either 

positive or negative. 

● Allow one response on each side - allow anyone to respond either on the positive or 

negative side. 

● Use debate teams - use teams feature instead which will control these for individual teams. 

2. Click on Save and Close or Save and Display if you selected debate teams in the previous step 

https://moodle.org/plugins/mod_debate
https://icourse.projectsgallery.eu/moodle/admin/tool/installaddon/index.php
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About Debate Teams Option: In order to create debate teams you need first to create groups and then 

create the Positive and Negative Teams. In order to create Groups watch the video at 

https://www.youtube.com/watch?v=3n5VFTggTt4 

18.5 Official website and link for download 

https://moodle.org/plugins/mod_debate 

18.6 Platform for Development 

Moodle 

18.7 Generated Content and compatibility with the LMS and CMS platforms 

Activity in Moodle 

19 Real Time Quiz 

Activity 

19.1 A short description of the software and its main capabilities 

Each student receives each question at the same time with a time limit to answer it (default 30 seconds). In 
between each question the correct answer is displayed, along with the number of students giving each 
answer, This allows each question to be discussed before moving on. 

Teachers can review the answers, once the quiz is finished, to identify any areas that need to be covered 
again. 

19.2 Features 

The RealTimeQuiz allows to create a quiz where each Question is presented at the same time to students. 
The Teacher or Administrator can 

1. Create a quiz with a list of questions 
2. Set the time given to answer a question (30 seconds is the default) 
3. View statistics about the percentage class / individual correct answers. 

19.3 Guidelines for installation and usage 

In order to install this plugin in Moodle you need to have administrative rights on the platform.  

1. Download the plugin from https://moodle.org/plugins/mod_realtimequiz 
8. Login in Moodle with site wide administrative rights 
9. Click on Site Administration 
10. Select the Plugins tab 
11. Click on Install Plugins 
12. Under the “Install plugin from ZIP file” click on Choose file and from the File Piker window click on 

Choose file. 
13. In the window titled “Open” navigate to the folder where the zipped file is located (that is the 

zipped file you downloaded in step 1) and click on Open  
14. Finally, click on install plugin from the zipped file and follow the steps. 

19.4 How to / tutorial 

Watch the video https://youtu.be/VwCwBstM_fQ to understand how RealTime Quiz works 

 

https://www.youtube.com/watch?v=3n5VFTggTt4
https://moodle.org/plugins/mod_realtimequiz
https://icourse.projectsgallery.eu/moodle/admin/tool/installaddon/index.php
https://youtu.be/VwCwBstM_fQ
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To create an activity with RealTime Quiz 

1. Click on Add an Activity or Resource 
2. Select the RealTime Quiz activity 
3. Type in a name and optionally a description 
4. Under the Realtime quiz settings type the number of seconds students will have to answer each 

question. The default is 30 seconds 

 
5. Click on Save and Display. The RealTime Quiz screen appears 

 
6. Click on the Edit Quiz tab 
7. Click on Add Question 
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8. Type in the Question and the answers below. Make sure you select the correct answer 
9. Click on the Breadcrumbs to go back to the course page.  

19.5 Official website and link for download 

https://moodle.org/plugins/mod_realtimequiz 

19.6 Platform for Development 

Moodle 

19.7 Generated Content and compatibility with the LMS and CMS platforms 

Activity in Moodle 

 

 

  

https://moodle.org/plugins/mod_realtimequiz
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20 GoodHabits 

Activity 

20.1 A short description of the software and its main capabilities 

This plugin enables learners to monitor their habits over time. It provides a flexible calendar system that 
can be customised to track activities on a day-by-day basis, a week-by-week basis, or over a range of days. 
The entry system is designed to encourage reflection on activities that are related to online learning. This 
can help reveal trends over time which can shape learners' attitudes and motivation. 

This is an activity module, so you must first add it to a course as an administrator or teacher. You can then 
create Activity Habits to track, which are visible to everyone using the activity. Learners can also create 
their own personal habits, visible only to themselves. They can also add a break to their habits, for 
example, to account for holiday time. 

20.2 Features 

GoodHabits activity allows 

1. The teacher to define a set of GoodHabits that will be available for all the students to monitor their 
performance over time 

2. The student to specify their own set of GoodHabits to monitor their performance over time 
3. Add breaks, where the specified dates will not be available for habit monitoring 
4. The teacher to review his/her students GoodHabits performance 

20.3 Guidelines for installation and usage 

In order to install this plugin in Moodle you need to have administrative rights on the platform.  

1. Download the plugin from https://moodle.org/plugins/mod_goodhabits 
2. Login in Moodle with site wide administrative rights 
3. Click on Site Administration 
4. Select the Plugins tab 
5. Click on Install Plugins 
6. Under the “Install plugin from ZIP file” click on Choose file and from the File Piker window click on 

Choose file. 
7. In the window titled “Open” navigate to the folder where the zipped file is located (that is the 

zipped file you downloaded in step 1) and click on Open  
8. Finally, click on install plugin from the zipped file and follow the steps. 

20.4 How to / tutorial 

Watch the video to understand how GoodHabits Works: https://youtu.be/t5myhN3wvAc 

 

To create an activity with GoodHabits: 

1. Click on Add an Activity or Resource 
2. Select the GoodHabits activity  
3. Type in a name and optionally a description 
4. At the bottom click on Save and Display 
5. In the next windows you have 4 buttons: 

● [Admin] Manage habits for everyone: Here you can add Habits which will be global. By global it 
means that the habbits will be available for all users.  

● [Admin] Review entries: Here you can review  

https://moodle.org/plugins/mod_goodhabits
https://icourse.projectsgallery.eu/moodle/admin/tool/installaddon/index.php
https://youtu.be/t5myhN3wvAc
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● Manage habits: Here you can add Habits which will be avialable to use only by the user currently 
logged in  

● Manage Breaks: Here you can add breaks such as holidays, time off etc. 
6. Let’s assume you wish to add some habits that will be available to everyone. Therefore, click on 

[Admin] Manage habits for everyone. 
7. In the next window, type in a habbit (i.e. Reading 30 min per day), optionally add a description and 

make sure that Show is selected next to the Show option 
8. Click Add habit for everyone.  
9. Repeat steps 7-8 to add more habbits. 
10. Once done, click on Go Back to test Good Habits 
11. In the next screen, click on the circle that corresponds to the habit and date, and click on the chart 

to show your effort and outcome 

 
12. Click Save. 
13. Repeat steps 11-12 for each Habit to enter your score. 
14. As an Administrator or a Teacher, you may review the habits of the students. Click on [Admin] 

Review entries, and in the Select text box type in the name of the student. While typing a list will 
appear in order to select the student. 

15. Click on Review User Entries to view the student’s score on the various Habits.   

20.5 Official website and link for download 

https://moodle.org/plugins/mod_goodhabits 

20.6 Platform for Development 

LMS Moodle 

20.7 Generated Content and compatibility with the LMS and CMS platforms 

Activity in Moodle 

 

 

 

https://moodle.org/plugins/mod_goodhabits
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21 QuizVenture 

Game based Learning 

21.1 A short description of the software and its main capabilities 

Quizventure is an activity which makes an arcade-type game from multiple choice and matching questions 
in the Question bank. Possible answers come down the screen as spaceships and students have to shoot 
the correct one to gain points. 

21.2 Features 

QuizVenture uses the questions from a question category in the Question bank. Two types of Questions 
can be used: multiple choice and matching questions 

21.3 Guidelines for installation and usage 

In order to install this plugin in Moodle you need to have administrative rights on the platform.  

1. Download the plugin from https://moodle.org/plugins/mod_quizgame 
2. Login in Moodle with site wide administrative rights 
3. Click on Site Administration 
4. Select the Plugins tab 
5. Click on Install Plugins 
6. Under the “Install plugin from ZIP file” click on Choose file and from the File Piker window click on 

Choose file. 
7. In the window titled “Open” navigate to the folder where the zipped file is located (that is the 

zipped file you downloaded in step 1) and click on Open  
8. Finally, click on install plugin from the zipped file and follow the steps. 

21.4 How to / tutorial 

1. As a course teacher make sure you have some multiple choice or/and matching questions in your 
question bank. 

2. Quizventure only uses these two question types, and for one game, the questions must all be in the 
same category. 

3. With the editing turned on, select Quizventure from the Activity chooser. 
4. Give your game a name and if required a description and choose the question category from which 

you want to draw the questions for this game. 
5. Save the game. 

21.5 Official website and link for download 

https://moodle.org/plugins/mod_quizgame 

21.6 Platform for Development 

LMS: Moodle 

21.7 Generated Content and compatibility with the LMS and CMS platforms 

Activity in Moodle 

 

 

 

https://moodle.org/plugins/mod_quizgame
https://icourse.projectsgallery.eu/moodle/admin/tool/installaddon/index.php
https://moodle.org/plugins/mod_quizgame
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22 MindMap 

Activity 

22.1 A short description of the software and its main capabilities 

This Mindmap module allows you to create and save simple mindmaps from within moodle. 

22.2 Features 

Provides the capability to teachers  to create and save a mindmap. At any given point in time, provided 
that teacher allows it,  a single user can edit the mindmap. 

22.3 Guidelines for installation and usage 

In order to install this plugin in Moodle you need to have administrative rights on the platform.  

1. Download the plugin from https://moodle.org/plugins/mod_quizgame 
2. Login in Moodle with site wide administrative rights 
3. Click on Site Administration 
4. Select the Plugins tab 
5. Click on Install Plugins 
6. Under the “Install plugin from ZIP file” click on Choose file and from the File Piker window click on 

Choose file. 
7. In the window titled “Open” navigate to the folder where the zipped file is located (that is the 

zipped file you downloaded in step 1) and click on Open  
8. Finally, click on install plugin from the zipped file and follow the steps. 

22.4 How to / tutorial 

To create an activity with MindMap: 

1. Click on Add an Activity or Resource 
2. Select the MindMap activity  
3. Type in a name and optionally a description 

 
4. Select whether you wish the students to be able to edit the mind map 

https://moodle.org/plugins/mod_quizgame
https://icourse.projectsgallery.eu/moodle/admin/tool/installaddon/index.php
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5. At the bottom click on Save and Display 
6. In the next screen use the Add node and Add Edge buttons to create a mind map 

 
7. Once done click on Save Mindmap. 
8. Click on the Breadcrumbs on the top to go back to the course. 

Important Note: In order for students to edit the mindmap, the teacher or any other student cannot be in 
editing mode at the same time. 

22.5 Official website and link for download 

https://moodle.org/plugins/mod_mindmap 

22.6 Platform for Development 

LMS: Moodle 

22.7 Generated Content and compatibility with the LMS and CMS platforms 

Activity in Moodle 

  

https://moodle.org/plugins/mod_mindmap
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Learn more about the project at  http://icontent.projectsgallery.eu 

http://www.itee.radom.pl/
http://www.editc.eu/
https://www.bee.gr/
https://www.rinova.co.uk/
https://www.gruppo4.com/
http://icontent.projectsgallery.eu/

